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c8The figure below shows a typical landscape design for some community recreational facilities. The design features tennis courts, BBQ areas, children’s play zones 
etc. Note the series of tabs lined up across the bottom of the screen just above the command area. These show different aspects of design implemnation - from 
instruction about demolition procedures, to the actual landscape plan itself together with details of how to plant particular species etc. These layout views are a 
powerful feature of gCADPlus as it is very easy to switch from one layout view to another to show different aspects of the design. All generated from one model.

Managing layout spaces and printing
Layout tabs are used to present the design as it will appear when printed out onto cut sheets - A2, ARCH C size etc.

Typical design in model space showing layout tabs 
across the bottom of the screen.
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Clicking on any of these layout tabs switches gCADPlus to a series of views, each mimicking a paper print of the design. The display is predominantly white with 
a grey background. The white background is meant to represent the paper on which the design will be printed and the grey zone, a desktop. In the example shown 
below, construction details, including a setout table, are presented on one sheet ready for use by the construction team. Several flaoting viewports are used to present 
different aspects of the design. Even though the text here is seen here in yellow, since the sheet will be printed in monochrome text will be black. Other sheets show 
hardscape demolition instructions and specialized planting details. These will usually be printed in color. Note that layout spaces will normally contain title block 
information - location of site, designer’s name, date, drawing file name etc that is usually placed directly into layout space and not derived from model space. 

Switching to a layout tab shows this view. A legend shows at left and a table of 
setout points is seen on the right of the plan.

Survey the use of layout space in a typical landscape design.
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Here images of plant species use in a design for a property in Ft. Lauderdale, 
Florida are have been placed on a layout sheet along with suitable images 
to illustrate species chosen for the design. These were located in SppDb, the 
companion plant database to gCADPlus. Tip: for a closer look at the drawing, 
use the magnify tool in your PDF browser to magnify the image.

Placing entities - Model Space vs Layout Space

In a gCADPlus drawing file, it is possible to place entities in either:

•	 Model space or

•	 Layout space.

Model space is the space where a full size model is constructed by accurately 
placing lines, circles and other entities to describe the design. Model space in 
a typical job might include site boundaries, building footprint, north indicator, 
scale bar as well as the information describing the new design. For simplicity and 
clarity, CAD users usually develop landscape designs in model space at full size 
(sometimes referred to as full scale). The key factor is that entities reflect the true 
(actual) size of structures on the ground. For instance, when drawing a doorway to 
a courtyard in CAD, the door would be drawn 3 feet (900 mm) wide, a courtyard 
wall might be 6,245 mm (20 ft 6 inches long) - and so on. Any distance enquiry in 
model space such as use of the distance command, should give the same answer 
as you would get when measuring with a tape on site. 

However, since these drawings (models) get placed on sheets of paper that are 
much smaller than the actual site, a scale factor is required so that the final 
drawing has a usable conversion factor. That’s where layout space comes in. 
Layout space is the place where an ‘impression’ of what the design will look like 
when printed on a sheet of paper is shown. A typical layout might include a title 
block, images and perhaps detail of planting techniques as well as the design 
itself. 

An example of a typical layout sheet for a design for the front garden of a 
house in Florida is shown at right. The design itself is shown inside what is 
called a floating viewport. Other elements that illustrate design concepts such as 
photographs of species to be used and the designer’s logo are placed directly on 
the layout sheets. To reiterate, model space reflects the ‘real world‘, while layout 
is a paper or presentation space view of the design ready to show the client. As 
you will see later, it is possible to apply an accurate scale factor to the floating 
viewport containing the design and label it 1/96, 1:100 or 1/8” - 1 foot etc.
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Setting up a new layout

To create a new layout space, follow the steps below.

1. Check the size of your design in model space
Before creating a new layout sheet, make sure that a distance enquiry using the 
measuring tool gives the expected result. In the example shown, a 5 meter scale 
bar has been inserted into the design. 

Tip: Including a scale bar in model space is a good idea for a number reasons 
apart from providing an internal check. 

To do this, use the distance command (selected from the standard toolbar or 
the Tools drop down menu) to check the length of the bar. There is always the 
possibility that entities have been inadvertently scaled without you being aware 
of it. The figure shows that a correct value is given. As time goes by and you 
become more confident with CAD and especially where you expect construction 
teams to take dimensions from the model, this step becomes less important.

Tip: Scaling a model space drawing up or down is not recommended. Instead, 
scale title blocks up and down all you want in layout spaces, but not the drawing 
itself. It is only at the final assembly of the drawing on the layout sheet that a 
scale factor is considered.

2: Create a layout 
Select the Format drop down menu, then choose Create 
Layout.

Include a scale bar in model space as an extra check. Here a metric drawing - 
scale bar shows 5 meters.

Select layout from Format 
drop down menu
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A Page Setup dialog box shown at right (partly obscured) appears. A new layout is 
created by selecting the button at top left of the dialog box (circled in the figure). 
The desired sheet size can then be selected from the drop down list. Rather than 
accept the size of sheet for the attached default printer, it is recommended that you 
select a sheet size appropriate for your final plot and scale. 

Tip: To identify wrongly placed entities, use the zoom extents option in model 
space before using the create layout tool. 

Tip: It is recommended that you give each of the layouts a meaningful name. The 
first sheet in this example has been labelled A1 Sheet 1:100 but Architectural C 
size 1/48 is equally good. After a while, you will more than likely dispense with 
the sheet name in the title as this can be determined from the Layout Manager. 
Names such as front entrance, wetland, deck, demolish, rear garden etc., then 
become more the norm.

Click OK and the new layout is created. The view will likely be zoomed in. To 
display the entire sheet, right click and select the zoom extent option. The design 
itself will be seen inside the border of the layout sheet that is drawn in the current 
color (red in the figure below).

Choose paper size.

Layout created.

A short movie showing how to create a new layout.
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The figure at right shows the floating viewport (selected by clicking on the edge 
of the frame) superimposed over the white background of the sheet. In this 
example, a portrait layout was chosen and we are about to move the flooating 
viewport and center it on the page.. 

Once selected, the viewport can be sized by moving handles at the corners or 
moved by selecting the handle in the middle of the viewport.

Tip: To view additional information when a floating viewport is selected, refer to 
the properties box.

Floating viewport 
selected by clicking on 
the frame edge.

Properties box, 
viewport frame selected

Properties box, no viewport  frame selected.
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3. Adjusting the view inside a floating viewport
When a layout is first created, it is likely that the 
desired view will not show. To adjust the view of 
waht is seen in a floating viewport, there are two 
steps:

1. Size and position the actual viewport (in layout 
space) on the page to its desired place, then 

2. Double click in the middle of the (newly created 
and positioned) floating viewport. 

gCADPlus will switch automatically back to model 
space. A magenta colored viewport will show on the 
background of model space. Size the view using the 
handles on corners and move it (using the handle in 
the center of the view). Make sure that you cover that 
part of the drawing you want to display.

When the correct view is in position, right click and 
select “Display on paper space”. 

The result is displayed below.

Note the rectangle with the dotted line. This shows 
the position of the floating view port on the paper. 
One final step is required to set the layout properly. 

Right click and select ‘deactivate the viewport‘. It 
is possible to rotate the magenta viewport frame in 
model space, but that’s not recommended.

Tip: If you need to rotate a frame, it is recommended 
that this be done before any text is applied, otherwise 
the text will also be rotated.
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Layout view set, but viewport 
needs to be deactivated.

Layout containing multiple floating 
viewports. Frame containing the 
design rotated 90 degrees.
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4. Selecting viewports
As you will see later, it can sometimes be difficult to select a viewport when 
adjustments to the displayed content or re-position the floating view port on the 
paper are required. This is especially the case if the color of the viewport edge has 
been set to white as shown in the examples shown at right.

If the viewport is difficult to select because its color 
is set white, use the crossing window option to select 
a viewport for subsequent adjustment.

Floating viewport selected - if more than one entity is selected by the crossing 
window, deselect by holding the shift key down and left click on the entity to be 
removed.
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To select a viewport, start a crossing selection box and select the viewport. This 
may result in several viewports and other entities being selected. To remove 
unwanted items from the selection set, press the shift key in conjunction and slect 
with a left click.

Tip: To enlarged or shrink  a viewport, drag on the handles. 

Tip: It is suggested that you put the floating viewport on a non-printing layer or 
change the color of the border to white (255) so it (the border) disappears from 
view. 

Tip: To copy viewports using the Edit drop down menu, copy a floating viewport 
from one layout to another using Edit>Copy>Paste. When doing so, take note of 
the coordinates of the bottom left of the viewport in order to paste the viewport 
accurately in place on the next sheet.

Tip: The Modify>Align objects tool on the Modify drop down menu can be very 
useful here.

Pasting illustrative images into layout space
Pasting images (photographs) of species used in a design into layout space is 
common practice. The figure below shows the location of an art installation along 
with a photo of the proposed artwork.

Adjust the positioning of viewports using the handles at corners and in the 
center.

This movie shows how to set up a new layout view and position the design 
appropriately.

This movie provides a comprehensive overview of the use of layout spaces.
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Copy and paste images
SppDb, a companion plant database application can be used to simplify this 
process. If SppDb and gCADPlus are run concurrently, it is possible to search for 
and select an image to illustrate the species. SppDb stores the path to the image 
file so it is easy to paste the illustratiion into layout space.

SppDb is started from the Tools drop down menu.

To insert a copy of the image from SppDb into your drawing use Draw>Raster 
Image, switch to SppDb, find the required image and copy the path to the image 
into the add file field of the Insert Raster dialog box. 

Tip: The image file can be pasted in model space or layout space. Our preference 
is to past images directly in layout space using the path to the image file copied 
from Sppdb as shown.

Tip: This pasting technique can extend to photos of any hardscape elements you 
wish to add.

Copy the path to an image file from SppDb, the companion plant database 
application.

Artwork installation specified for landscape design

This movie shows how to manipulate images in gCADPlus designs.
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Using the companion plant database application 
(SppDb) speeds the selection and insertion of images 
to illustrate a design.
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Adding details to a new floating viewport
gCADPlus also lets you add various details to illustrate designs. The example 
below shows detail on how to plant an advanced specimen. This information 
needs to be displayed in layout space, but in contrast to the photograph of the art 
work, it might need to be located in its own floating viewport. This is a must if a 
defined scale for the detail is required.

Add a new viewport to an existing layout
The layout manager is used to create a new floating viewport and is activated by 

right clicking on the tab for the particular layout. The new viewport can be placed 
on top of the one containing the design or the viewport containing the existing 
design can be moved to accommodate the new viewport. 

Tip: It is easier to create the new viewport outside the existing frame as shown 
below. Adjusting what is to be displayed in the viewport is much easier. The 
viewport is then moved into position once it is set to show the required view.

Position a new viewport off to the side of the image for ease of 
manipulation. Move back to position later.

Insert tree planting detail in model space. Create a new viewport to 
display it on the layout sheet.

Add a new 
viewport from 
the layout tab.
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It is a good idea to put plant schedules in its own floating viewport.

At this stage, the title block information might be added to the layout view. The design is by no means 
be complete, but it is a good idea to generate a test PDF print at this stage. The reason is that you need to 
confident that the information on various layout sheets is sized correctly, text height appropriate and line 
weights and linetype patterns are correctly displayed before doing too much detailed work. If they are not, 
return to the model and correct them. Follow the updated settings in any new work. The match properties tool 
can be useful here.

Tip: Before printing, make check that the PDF writer is set with the correct paper size and orientation before 
printing. Do not rely on a check plot on a small sheet.

A note on printing
It is possible to print from either model space or layout (paper) space. It is recommended that you print from 
paper space as the white background simulates the appearance of the final printed sheet.  

Display plant schedules 
in new viewport

The print dialog box.
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Printing a landscape design
Even though it is possible to print from model space, we strongly recommend printing from a layout space so the first step is to swing from model space to layout 
space. Then right click the mouse on the layout tab at the bottom of the screen and make sure that the appropriate page size is set via the layout manager. In the 
example below, we have chosen an A1 sheet in portrait mode. Once that’s done, check the properties of the floating viewport by selecting it and in particular, look at 
the color and scale properties. 

If you wish to print to a fixed scale, make sure that property is set to ‘Yes’.

 it is now time to activate the print command and show the print dialog box

Print a drawing to a fixed scale on an A1 sheet.
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If a drawing contains object property overrides instead of ByLayer, you’ll 
have plotting problems. For example, you want to plot a general landscape 
plan, you would not want to confuse them by showing dimensions, so you 
freeze the dimension layer. Oops, only half of the dimensions go away, but so 
do several paths, several plant symbols and maybe a set of outdoor furniture.

The dialog box is activated when print is selected from the File drop menu or by typing Control P shortcut, selecting the print icon on the standard toolbar or by typing 
the command directly. 

The number of options seen here can sometimes overwhelm new users. Here is a short check list.

Check that the current printer is the one you want. In the example below we are printing to CutePDF a PDF writer. 

Check that the resolution is appropriate - here 600dpi. The change tab allows this setting to be altered. Note that higher setting will increase the time taken to generate 
the plot.

Make sure that the chosen paper size matches the size set in the layout manager.

In the Printing Group, check that Paper is selected. This is the common selection. It is possible to select a Display, Windows or Extents option, but the intention here is 
to plot the drawing at a scale of 1:100.

The option ‘Center the print’ is usually ticked.

In the Print scale zone, Fit to paper is selected. Note that this automatically sets a scale 1:.992. That’s close to 1:1 and ceratinly good enough for most purposes if a 
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scale bar has been included in the design, but not quite what’s required. In order to print 1:100, 
that box needs to be unticked. 

Now its is time to preview the print. 

Print preview
The figure at right shows the preview box. If the design shows completely inside the red flashing 
box, the design is ready to be printed. 

The figure below shows what happend when the Display option is chosen rather than page so it is 
well worth running the preview option before committing to a print.

Sending the wrong view to a printer is not so much a problem when using a virtual printer such as 
CutePDF, but can lead to waste if the print job it sent to a printer attached to the computer.
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Print high resolution on a Mac using gCADPlus and CrossOver

Mac computers normally handle printing of PDF files from the operating system 
level. If you are using gCADPlus on your Mac under CrossOver and want to 
generate a reasonable quality PDF use the File > Save as PDF option. If however 
you need high quality PDF output, you need to install a PDF writer and print to it. 
Although we favor CutePDF as our PDF writer in the Windows environment, we 
have not has success with it on our Mac. 

The link below from the CrossOver people may help. They suggest that installing 
a freeware tool - PDFWriter - may work well and produce high quality PDF inside 
gCADPlus. We have been able to make it work and get high quality output as least 
as good as CutePDF, but it was a little fiddly to install (see note below).

https://www.codeweavers.com/…/wi…/mac/faq/printfromcrossover

We did have to reset the driver as set out at the end of the page cited above.

and a link to a download page for PDFwriter:

https://sourceforge.net/projects/pdfwriterformac/

You need to use version 1.2.1 of the PDFwriter modified 2011-03-15.

When installing, make sure that you choose the driver-file manually during the 
adding process of the printer. You can find it at following path: /Library/Printers/
Lisanet/PDFwriter/pdfwriter.ppd

If the install process has automatically added the printer, delete it and add it again 
choosing the driver above. If you allow an automated setup, your PDF files may 
contain zero bytes (i.e empty).

Printed from Mac using CrossOver. 
resolutions  > 1200 dpi are possible.
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Add an additional viewport to the same layout page

When a new layout is created using the layout tool on the format drop down menu, the new layout automatically contains a floating viewport. That viewport is 
drawn in the current color and located on the current layer. You have seen that it is possible to display any part of the design in model space in the floating viewport. 
Commonly, that would be the whole of the landscape design.

There are occasions when there is a requirement to show additional views from model space in a signle layout. You might want to keep the plant schedule in its own 
viewport. That’s done by right clicking on the layout tab corresponding to the layout you are working on and selecting Add Viewport. The figure below shows this tool 
in action in a design for a semi rural site.

This movie shows how to add an extra floating viewport to a layout page that already contains a 
viewport.
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Control visibility of layers within a floating viewport

There are occasions where it is advantageous to control the display of layers within floating viewport independently from the state of layers in the drawing as a whole.

This movie shows how to adjust the display of layers withing a floating viewport. We show how a knowledge of this technique can be 
used to reduce the amount of work (and duplication) of the design in model space.
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Printing from layout space - metric 

As mentioned, for simplicity and clarity, it is suggested that you develop landscape designs in model space at full size (scale) using mm as the base unit. For instance, 
when drawing a doorway to a double garage shown below it would be drawn 4810 units (mm), the garage itself 6040 units.  However, since these drawings get placed 
on sheets of paper that are much smaller, a scale factor is required so that the final drawing has a usable conversion factor. 

The first step in the process is via the Format drop down menu, to create a new layout. In the description that follows, we will choose an A3 size sheet as it is the most 
common sheet size used by landscape designers. A floating viewport automatically appears on the sheet as the layout is created. The border is drawn in the current 
color and on the current layer. The viewport is a ‘window‘ into the design. The figure below shows the result. There is no fixed scale at this stage - scaling in the 
floating viewport is purely arbitrary.

Printing a design - from layout space.
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The design appears inside a floating viewport - very often zoomed in. To see the 
whole sheet (in this example an A2 sheet) right click the mouse and use Zoom 
Extents
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Printing to a fixed scale - metric
Scaling to a fixed value is often required. This is conveniently done by selecting the “set fixed scale tool” 
from the modify drop down menu and (responding to the prompt) pointing to the edge of the floating 
viewport. 

It is then simply a matter of responding to the prompts in the command line - choosing Metric and then (say) 
1:50. This produces a view suitable for presentation of the front space and entrance.
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In this example, a value of 1:100 shows the entire site.

Tip: It is a good idea to issue the zoom extents option before selecting “Set fixed scale”.

It is also possible to set the scaling factor by typing a number in the properties box with the floating viewport selected.
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Always run a check plot before going too far
It is a good idea at this point to test how the design might look when printed. We suggest printing to a PDF writer such as CutePDF, selecting the appropriate size 
sheet.

Tip: Preview the plot at scale 1=1 (Remember, the actual 1/50 or 1:100 scaling is done inside the floating viewport, but printing is done at 1:1 when an accurate scale 
is required.)

It is also possible to select the floating viewport and type a value (50, 100, 200 etc.) in the Properties box directly. Fixed scales are effected by typing a value selected 
from the table below into the View Scale field by in the properties box when the layout frame is selected. The set fixed scale option must be set to yes. These steps are 
the ones automated by the setfixedscale command.
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Printing from a layout sheet - USA (Imperial) system

For simplicity and clarity, it is suggested that you always develop landscape designs at full size (scale). For instance, when drawing a 
doorway in CAD, the door would be 3 feet wide, a courtyard wall might be 20 ft 6 inches long (entered as 20.5 decimal feet).  However, 
since these drawings get placed on sheets of paper that are much smaller, a scale factor is required such that the final drawing has a usable 
conversion factor. These scale factors in the US may be expressed in terms of a relationship between an inch and a foot. Example 1/8” to 
1 foot 0 inches; alternatively such a scale is referred to as 1/96.

Imagine a site measuring approximately 200 units (feet) across. If it were plotted onto an ANSI C size sheet (22 inches wide - 
approximately 2 feet), a rough calculation would suggest that a scale factor somewhere near 200/2 i.e.1/96 (1/8” to 1 foot) or perhaps 
1/64 (3/16” to 1 foot) would be required to show the design on the C sheet.

The first step is via the Format drop down menu, is to create a new layout. We will choose in this case, an ANSI C size sheet - ARCH C 
size is also available. A floating viewport automatically appears on the sheet as the layout is created. The border is drawn in the current 
color and on the current layer. The viewport is a ‘window‘ into the design. The figure below shows the result. There is no fixed scale at 
this stage - scaling in the floating viewport is purely arbitrary.
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Printing to a fixed scale USA
Scaling to a fixed value is required. In gCADPlus this is conveniently done by selecting the set fixed scale tool from the modify drop down menu and (responding to 
the prompt) pointing to the edge of the floating viewport. 

Once the Imperial mode for scale is chosen, a series of possible scale factors is presented in the command line and shown in the figure below.. The default value here is 
1/32, but we have calculated that 1/96 is a likely candidate, so that new fraction (1/96) is typed. The enter key is pressed to set the new scale. 

Tip: It is a good idea to issue the zoom extents option before selecting “Set fixed scale”.
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Check plot
It is a good idea at this point to test how the design might look when printed. To that end, we print to a PDF writer such as CutePDF, 
selecting the appropriate C size sheet.

Preview the plot at scale 1=1 (Remember, the actual 1/96 scaling is done inside the floating viewport, but printing is done at 1:1)

It is also possible to select the floating viewport and type a value in the Properties box directly. Fixed scales are effected by typing a value 
selected from the table below into the View Scale field by in the properties box when the layout frame is selected. The set fixed scale 
option must be set to yes. These steps are the ones automated by the setfixedscale command.

The following table shows the values to be typed in the scale field of the properties box to achieve desired Imperial scales. The values in 
the column at left enable a conversion from a drawing in decimal feet to a plot on a metric piece of paper (1 foot is close to 300 mm [exact 

A value of 0.32 is automatically fed to the scale field in the 
Properties box (see later) when the scale 1/96 is typed.
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304.8) e.g. 192/300 = 64

Value to type in 
Properties box

Required scale 1/X USA notation

0.04 1/12 1: to 1 foot
0.08 1/24 1/2" to 1 foot
0.16 1/48 1/4" to 1 foot
0.32 1/96 1/8" to 1 foot
0.64 1/192 1/16" to 1 foot

Tip: The data in the box above was taken from an Excel spreadsheet and rounded for convenience.

Now is a good time to return to model space and add to the design. For example, you might want to add explanatory text, shadowing, 
paving details etc. You can do this with confidence because when the final plot from layout space is generated, an accurate scale factor can 
be placed on the sheet.

Tip: The value Scale 1:96 can be placed in model space or on the layout sheet; possibly in the title block.

Adding images to layout spaces

Our plant database application can be used on top of gCADPlus and used to search for images to illustrate the characteristics of plant 
species in a design.

This movie surveys the use of plant databases while designing.
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Handling line thickness (lineweight)

The images of the design shown above were developed 
without turning display of line weights (lineweight) 
on. Most professional landscape design drafters would 
prefer to apply line weights to their drawing, because 
doing so makes for clarity. gCADPlus features a line 
weight display tool. Clicking the LWT button turn 
the display of lineweight on. The images here shows 
the sample drawing with display of lineweights 
turned on and off. Note the marked difference in the 
appearance of some symbols. Symbols can be edited 
and lineweight values altered if required.

Lineweight display off above.

Lineweight display on.
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Setting lineweights in working drawings
There is a complex interaction between the lineweight value applied to a particular entity, the layer that an 
entity is located on, whether or not an entity is a block (and the layers within the block, the lineweight setting 
for the layer and the current value for display of lineweight.

Lineweight settings for a group of 
layers in a drawing.Set lineweights
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To illustrate, the image below shows this same design where lineweight display of all layers in the drawing is 
set to default (this is the layer lineweight arrangement in place when you start a new gCAD+ drawing). This is 
probably the easiest way for beginners to control lineweight.

How dark the image will appear on screen is dependent on the setting under Format>Lineweight
If the default for lineweight display is set to 0.00 (thinnest line) the design will be lightly drawn as shown 
below. 

Display setting zero, all entities 
lightly drawn.

Controlling lineweights
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If the general display of lines in the drawing is not dark enough for your liking, it is a simple matter to change 
the thickness of lines by changing the display default value. 

In the figure below, we have changed the lineweight to 0.016 inch as we are working in a USA drawing. All 
lines are much darker. It is a simple matter to experiment with this display value until the desired effect is 
obtained.

Display setting 1/16” - linework 
emphasized.
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It is a good idea to run a quick check plot to PDF to ensure the display value meets your desired standard.

Display setting 1/16” - line work emphasized - check PDF 
print. A little too dark perhaps.
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A value somewhere between 0.000 inch and 0.016 inch should give a reasonable compromise between enough definition for line work without any bleeding of symbol 
detail. The figure below shows the result with a value of 0.06 inch for default lineweight.
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Varying lineweight in individual entities
The above description focused on applying general line thicknesses. However, a drawing can be given much more ‘life’ if attention is paid to setting line thicknesses 
on individual entities.

Tip: Paying attention to lineweight is especially important where the border and title blocks are concerned. The figure below shows that if the border and the lines 
representing the house footprint have been assigned a heavier line weight, the ‘readabliity’ of the drawing improves.  

Note that even though lineweight display is on, the plant symbols are lightly drawn.

Tip: Line weight can also be controlled by layer settings. In our view it is important to have a clear idea how line weights are being controlled in a particular design. .

It can be tricky to manage this process of adjusting lineweights unless you have a clear understanding of the behavior of layers and lineweight settings inside block 

Specific lineweight applied to the lines indicating the footprint 
of the house.



gCADPlus User Guide v2.0 172
gCAD+

entities.

The value of controlling line weight is very apparent in this sheet showing a cross section through the water feature. The dimension lines are drawn with a finer line 
weight than the water feature itself.
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Printing designs where transparency has been applied to enity color 

If color transparency has been applied, it can be challenging to print the design to get a satisfactory output.
This movie shows everything you ever needed to know about printing landscape drawings where the drawing contains entities with color 
transparency applied. In the movie, we show how to print to BullZip, a traditional PDF writer for high resolution output and compare the 
output to that generated by the inbuilt gCADPlus ‘Save As PDF’ tool.
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